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Legal Information

Important Information

Texas Instruments makes no warranty, either expressed or implied, including
but not limited to any implied warranties of merchantability and fitness for a
particular purpose, regarding any programs or book materials and makes such
materials available solely on an “as-is” basis.

In no event shall Texas Instruments be liable to anyone for special, collateral,
incidental, or consequential damages in connection with or arising out of the
purchase or use of these materials, and the sole and exclusive liability of Texas
Instruments, regardless of the form of action, shall not exceed the purchase
price of this product. Moreover, Texas Instruments shall not be liable for any
claim of any kind whatsoever against the use of these materials by any other
party.

This graphing product application (APP) is licensed. See the terms of the
license agreement.

© 2006 - 2015 Texas Instruments Incorporated

Windows, NT, Microsoft, Apple, and Macintosh are trademarks of their
respective owners.
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Introduction to the TI Connect™ CE Software

The Tl Connect™ CE software makes exchanging information between your
graphing calculator and your computer quick and easy.

Supports any TI-8x graphing calculator with a USB port, which include:

TI-84 Plus CE

TI-84 Plus CE-T

TI 84 Plus C Silver Edition
TI-84 Plus

TI-83 Premium CE

TI-83 Plus.fr

TI-82 Advanced

Note: Use Tl Connect 4.0 which supports calculators with an I/O port only:

TI-83 Plus
TI-89

Voyage 200
TI-73 Explorer

Introduction to the Tl Connect™ CE Software
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Using the Tl Connect™ CE Software Window

The Tl Connect™ CE software window contains tools you can use to exchange
information between your calculator and your computer.

£2 71 Connect™ CE = |5 et

File Edit View Actions Help
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Press [8] to capture calculator screens

The Tl Connect™ CE software includes three workspaces:
»  Screen Capture: allows you to manage screen captures
*  Calculator Explorer: allows you to manage calculator content

*  Program Editor: allows you to work with data variables
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Parts of the TI Connect™ CE Software Window
£2 T Connect™ CE — ‘ =y~

File Edit View Actions Help

CONNECTED CALCULATORS (1)
N
IRE 4
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Press m to capture calculator screens

o Menu Bar - Use these menus to manage calculator files and screens to
view calculator information, and to get help.

File Edit Actions Help

e Toolbar - Use these icons to manage computer files and screens.

@ Workspace Panel- Use this panel to select workspaces (Screen
Capture, Calculator Explorer, and Program Editor).

O]

SCREEN
CAPTURE

o

CALCULATOR
EXPLORER

L]
am
PROGRAM
EDITOR
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Calculator List Panel - Use this list to view all connected calculators
and to select one calculator for display.

CONNECTED CALCULATORS (1) (O]

T1-84 Plus CE - 1B89 @

0550

Content Panel - Use this panel to view and manage the calculator files
and screen on connected calculator(s).

ress [€] to capture calculator screens
P 8] t it lculat

Note: You can complete most of the actions in these menus by
dragging and dropping items to your connected calculator or
computer.
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Using the Screen Capture Workspace

The Screen Capture workspace allows you to manage calculator screen
captures.

#2 TI Connect™ CE = |E) >

(0] CONNECTED CALCULATORS (1)
“Capture 1 x
TI-84 Plus CE - 1889 NORMAL FLOAT AUTO REAL RADIAN MP m
0550

CALCULATOR
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EDITOR

“Capture 2 x
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Parts of the Screen Capture Window

Menu Bar - Use these menus to manage files and images, to view calculator
information, and to get help.

File Edit View Actions Help

Note: You can complete most of the actions in these menus by dragging
and droppings items from the Content Panel.

Toolbar - Click these icons to save, send, copy, delete, and resize files.

Save a file to the computer.

Send a file to a calculator.

Copy afile.

Delete afile.

Add or remove a border from all captured screens.

Change the size of all captured screens.

O S O O & e

View the screen capture size.

Content Panel - View screen captures in the Content Panel.

*Capture 1 x

1]

NORMAL

FLOAT AUTO REAL RADIAN HP
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Capturing and Using Screens

In the Screen Capture workspace, you can capture and view screens from your
calculator.

Before you Begin

Connect the calculator to the computer and make sure itappears in the
Calculator Panel.

To Capture Calculator Screens

1. On the TI Connect™ CE software Workspace Panel, click the Screen
Capture workspace.

2. Display the screen on your calculator that you want to capture.

3. Click next to the desired calculator in the Calculator List Panel.

. If more than one calculator is connected, click on CONNECTED
CALCULATORS to capture screens from all calculators.

Saving Calculator Screens as Files

The Screen Capture workspace lets you save captured or existing images from
your calculator as a PNG.

*Capture 1 X

NORMAL FLOAT AUTO REAL RADIAN HMP n

Note: The asterisk at the beginning of an image name indicates that the image
is not saved.

To save an existing screen

1. Click the captured screen in the Content Panel.
2. click Bl

Using the Screen Capture Workspace 7



To save multiple screens
1. Click Edit > Select All.

2. click Bl

To rename a screen capture

1. Place your cursor at the beginning of the screen name field.
Ex: Capture 1.

2. Double-click the name to selectiit.

3. Type in a new name for the computer file.

To save a new screen capture as a PNG file
1. Click the image.

click Bl

Navigate to a desired save location.

2
3
4. Use the default file name or type a new file name.
5. click Bl

To send screen captures to connected calculators

This Screen Capture only feature provides a way to take a screen capture of a
graph on the high resolution calculators, crop to the graph area and then
convert only the graph area to a Background Image. Check Graph Area Only to
create this type of Background Image.

1. Ifyou have not already done so, capture the screen.

2. Click the screen capture to select it.

|
3. CIick
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= Send to Calculators = X

FILE NAME: NAME ON CALCULATOR: LOCATION: i ]

Capture 1 Imagel i \/

.| Graph Area Only

Screen captures and converted image files will be sent as Pic Vars to black and white
calculators

DESTINATION CALCULATORS:
® All Connected Calculators o Select Calculators

|| Replace existing content with the same name on destination calculators

Cancel Send

FILE NAME: This may differ from the NAME ON CALCULATOR depending
on what you named the screen capture on your computer.

NAME ON CALCULATOR: select the background image (it should be the
default, but you may change the background image name using this
menu).

GRAPH AREA ONLY: In the right panel, select whether you want to send

justthe graph area, or the entire screen. When sending a screen capture
back to a calculator, it is best to send the graph area only.

Cropping an Image

A screen capture of the graph area includes the full screen of the
TI-84 Plus CE, status bar, graph border, and the graph area.

TI Connect™ CE software allows you to crop the image to a Graph Area
Only size to create a Background Image Var. You can crop a screen to
Graph Area only in the Send to in the Send to Calculators dialogue box.

Using the Screen Capture Workspace 9



W7

WA | B

| Graph Area Only | Graph Area Only

+ DESTINATION CALCULATORS: Select whether you want to send the
image to all connected calculators, or just selected calculators (from a
check list).

Note: Screen captures and converted image files will be sent as Pic Vars to
black and white calculators.

To send files to multiple calculators

1. Select the Select Calculators button on the dialogue box.
2. Check the boxes next to the calculators you want to select.
3. Click Send.

Dragging and Dropping Screen Captures to Computer
Applications

Using the Screen Capture workspace, you can drag and drop captured
screens into many computer applications. This feature lets you use calculator
screens in your documents.

To drag and drop screens into computer applications

1. Open or capture the screen.

2. Drag and drop the screen to an open document or presentation computer
software application.

10 Using the Screen Capture Workspace



Using the Calculator Explorer Workspace

Calculator Explorer workspace allows you to manage calculator content.

&2 TI Connect™ CE

=|=

E CONNECTED CALCULATORS (1) TI-84 Plus CE
SCREEN
CAPTURE NAME
TI-84 Plus CE - 1B89
0550 012 v
o) ] mage2
e |'=| Imagel
[24] Images
A [E4] Images
(1] P
PROGRAM [5d] 1mage3
EDITOR
02 x
nz v
&} u
&} L
&} L
3
&3 L
£} .
D cabrire
[ celsheet

Archive: 2,050 kB available | RAM: 154 kB available

TYPE
Real Number
Background Image
Background Image
Background Image
Background Image
Background Image
Real Number

Real Mumber

Real List

Real List

Real List

Real List

Real List

Real List

Flash Application

Flash Application

22 kB
22kB
22kB

22k

LOCATION
RAM
Archive
Archive
Archive
Archive

Archive

Archive

Archive
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Parts of the Calculator Explorer Main Window

Menu Bar - Use these menus to manage files and images, to view calculator
information, and to get help.

File Edit View Actions Help

Note: You can complete most of the actions in these menus by dragging
and dropping items from the Content Panel.

Toolbar - Click these icons to add, transfer, or delete files from your calculator.

Dﬂ
@]

OO 0 6

Add content from your computer.

Send selected content to your computer.

Send selected content to another connected calculator.

Delete the selected file.

Refresh the view of a connected calculator's contents.

o~ ol o ) ®

Content Panel - Select files you want to manage from this panel.

T

EEEEEEE
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Selecting a Connected Calculator

The Tl Connect™ CE software allows you to connect multiple calculators
simultaneously. Click on the calculator you want to work with to selectit. The
selected calculator becomes the default calculator for all TI Connect™ CE
software actions.

Before you Begin

Connect the calculator to the computer and make sure itappears in the
Content Panel.

Copying Calculator Files to the Computer

You can copy most data, files, and programs from your calculator to your
computer as a content backup, to send to others, or to free up calculator
memory.

To copy a file from the calculator to the computer
1. Click on the file name to select it.

2. Drag and drop the file into a folder on your computer or onto your desktop.

Warning: Do not disconnect the cable during a transfer.

To copy a file from the computer to the calculator
1. Navigate to the desired file on your computer.

2. Drag the file to the Calculator List Panel and hover over the desired
calculator.

3. Release the mouse button when you see * Copy

4. Select a file name from the drop-down menu. This will be the name of the
file on your calculator.

5. Click Send.

Sending Files to Connected Calculators

You can send files to calculators connected to TI Connect™ CE software.

Warning: Do not disconnect the cable during a transfer.

To send files to connected calculators
1. Click the file(s) to selectit.

Using the Calculator Explorer Workspace 13



2. CIick.

=2 Send to Calculators (== X
FILE NAME: NAME ON CALCULATOR: LOCATION:
KALSCOPE8xp KALSCOPE 2 RAM g
DESTINATION CALCULATORS:
/Al Connected Calculators #) Select Calculators

of| TI-84 Plus CE-1B89

|| Replace existing content with the same name on destination calculators

CANCEL SEND

* DESTINATION CALCULATORS: Select whether you want to send the file to
all connected calculators, or just selected calculators (from a check list).

To send files to select calculators

1. Select the Select Calculators button on the dialogue box.

2. Check the boxes next to the calculators you want to select.

3. Click Send.

Converting and Sending Background Images
The TI-84 Plus CE can display background images and Pic Vars. These
variables display in the graph area.

Note: All information on background images also applies to the TI-84 Plus C
Silver Edition and the TI-83 Premium CE.
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Working with Background Images

The Tl Connect™ CE software automatically converts any image you send to a
connected calculator into a Background Image Var. Your image may display
differently in the graph area than you expect, given the conversion to the pixel
dimensions of 83 x 133.

Note: For best results, please edit your image to be proportional to 83 x
133 pixels prior to the conversion to 83 x 133 pixels.

The conversion to the Background Image Var uses 16-bit colour.

You can also upload a Background Image Var into the TI-84 Plus CE emulator
view in TI-SmartView™ CE software.

On the TI-84 Plus CE, a Background Image Var displays as the background in
the graph area only. A background image will display scaled for the MODE
screen settings of Full, Horizontal, and Graph-Table. This preserves any
mathematical modelling done on a background. You cannot edit a background
image while working on the TI-84 Plus CE. Background images run from and
are stored in Archive memory.

Using the Calculator Explorer Workspace 15



Sending a Background Image to a Connected Calculator

You can send a background image and display it in the graph area of the TI-84
Plus CE.

o g A~ w N

N

- = u
-
i

Open the Tl Connect™ CE software.

Choose the Calculator Explorer workspace.

Connect the TI-84 Plus CE to the computer using the cable.
Turn on the TI-84 Plus CE.

Choose the image you want to convert.

Drag the picture to the Calculator List Panel and hover over the desired
calculator.

Release the mouse button when you see % Copy

Select an Image# name from the drop-down menu (Image0 - Image9). This
will be the name of the image on the TI-84 Plus CE.

Note: The Image# name you choose becomes the image name on your
calculator. Note this Image# name (or make it part of the file name on your
computer) for identification when you want to send or share this file.

WARNING: Pre-loaded images are stored in Image1 - Image5. Use other
Image# to avoid overwriting the pre-loaded images.

Click Send.

Rename the computer file so you can identify your Image Var later (bridge,
fountain, etc.) The Image# internal calculator var name will not be
changed.

To save the background image to your computer, drag the Image# from the
Calculator Explorer to your desktop or to the folder where you want to save
it.
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+ Todisplay your new background image in the graph area of the
TI-84 Plus CE, press [format], change the Background setting to the
Image# you just sent to the calculator (example: Image5), and press [graph].

Note: From the graph screen on the calculator, you can also change the
Background using [draw]; BACKGROUND; 1:BackgroundOn interactive
command.

Deleting Calculator Files

You can delete data, files, and programs from your calculator.

To delete files from the calculator
1. Click on the file name to selectit.

2. Press .

Using the Calculator Explorer Workspace 17



Using the Program Editor Workspace

The Program Editor Workspace allows you to work with data variables.

£2 11 Connect™ CE (=5 s

TI-84 Plus CE
New Program

SCREEN

CAPTURE » Angle

» Catalog
» Char +
.O » Distribution
CALCuLATOR VIS

EXPLORER
» Format

> List
» Hath
» Matrix Open Program

-

» Hemory
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Parts of the Program Editor Workspace
£ T1 Connect™ CE (=

TI-84 Plus CE

SCREEN
CAPTURE » Angle e

» Catalog
» Char
O » Distribution

caicuLator [T
EXPLORER

New Program

» Format

b List :

» Hath e

» Matrix Qpen Program
» Memory

i

o Menu Bar - Use these menus to manage files and programs, and to get

help.

View  Actions Help

Note: You can complete most of the actions in these menus by
dragging and droppings items from the Content Panel.

@ Toolbar - Click these icons to add, open, and save programs, and to
send programs to your calculator.

+ =

@ Content Panel - Use this panel to create, view and edit programs.

-

Using the Program Editor Workspace
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0 Catalogue Panel - Use this panel to select your calculator type and then
choose from lists (by category) to create programs.

Angle

Catalog

Char

Distribution

Draw

¥y ¥ ¥ v v

Format
List
Hath
Hatrix
Hemory

Yy ¥ v v

@ Syntax Reference Panel - Use this panel to view the proper syntax of
each command along with required and optional arguments.

Creating a New Program

When no programs are open, the Content Panel displays only the New
Program and Open Program icons.

New Program

To create a new program

» Click the New Program icon. —I—
To open an existing program
1. Click the Open Program icon. -_‘
2. Navigate to the appropriate folder. -

3. Click Open.
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Editing a Var Name

New program names are PROG##. The numbers run in sequence, ex:
PROGO01, PROGO2.

To change the program name

» Click inside the Var Name box and type in a new name up to 8 letters or
numbers (first cannot be a number.)

VAR NAME: PROGO1

Protecting Your Program

TI Connect™ CE software allows you to protect your program from being edited
after the program is sent to a connected calculator.

To protect your program

» Click the check box next to the lock icon. bisi

Saving a Program to Your Computer

The asterisk at the beginning of a program name indicates that the program is
not saved.

To save a program

1. CIick.

2. Navigate to the appropriate folder.
3. Click Save.

Closing a Program

To close a program

» Click the x by the program name.
Using the Catalogue Panel

The Catalogue Panel contains a list of calculator commands, functions,
variables, and symbols you can use to create programs.
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To expand or collapse a Catalogue level
» Click the triangle beside each Catalogue entry.

» Angle
» Catalog VAR NAME: | PROGO7
» Char
» Distribution VErac
» Draw
» Format
» List
¥ Math

¥ Math

rDec
' (
FMin(
fMax
nDeriv(
fnlnt(
Zf
1ogBASE (
solve(
» Numeric
» Complex

» Probability
» Matrix

To place a Catalogue entry in the Content Panel

» Drag and drop the Catalogue entry into the Content Panel.

-OR-

» Double-click the Catalogue entry.

Note: Either of the above will place the Catalogue entry after the cursor.

Note: Itis a best practice to use the catalogue of commands and symbols to
paste to the editor to avoid syntax error due to incorrect use of upper and lower
case in commands. (Ex. nDeriv and not Nderiv; Thick and not thick)

Note: The commands are not made into the calculator commands (tokens) until
the program is sent to the calculator. If there is an error when your program
sends to the calculator or runs on the calculator, check to see if every
command in the calculator program edit mode is actually a command token.
When a command is a token on the calculator, the cursor will be on the first
character and then jump over the command as a token. If the cursor moves
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letter by letter through a command, that command did not get converted! Delete
and paste the command from the calculator.

Note: The language setting of TI Connect™ CE determines how the text is
interpreted as a command token for the calculator. Opening programs and
sending back to the calculator with TI Connect™ CE in different languages may
resultin undesired command tokens leading to syntax errors.

Using the Syntax Reference Panel

The Syntax Reference Panel displays the syntax of each Catalogue entry,
including required and optional arguments.

Sending a Program to a Calculator

You can send a program to a connected calculator.

To send a program to a connected calculator
1. Ifyou have not already done so, save the program.

2. CIick.

*  FILE NAME: This may differ from the NAME ON CALCULATOR depending
on what you named the program on your computer.

+  NAME ON CALCULATOR: select the program name (it should be the
default, but you may change the program name by clicking Custom).
Name on Calculator | = X

Custom Program names can be up to 8 characters in length
The first character can be A-Z or 8.
The remaining characters can be A-Z, & or 0-9.

CANCEL

+ LOCATION: Choose whether you save the program in the calculator's RAM
or Archive.

* DESTINATION CALCULATORS: Select whether you want to send the
program to all connected calculators, or just selected calculators (from a
check list).
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To send programs to multiple calculators

1. Select the Select Calculators button on the dialogue box.
2. Check the boxes next to the calculators you want to select.
3. Click Send.

Language Settings

If you wish to develop a Tl-Basic program in a different language from your
computer OS language setting, you can re-launch Tl Connect™ CE in another
language.

1. Select File > Change Language.

2. Selectthe language change after restart of the application.

| i i
2 Choose a language = 28 |

Language changes will take effect after application restart.

English (US) v

QUIT LATER QUIT NOW CANCEL

*  QUIT LATER - Retains the language selected and Tl Connect™ CE will
launch in this selected language the nexttime Tl Connect™ CE is
launched.

*  QUIT NOW - Restarts Tl Connect™ CE in the selected language.

*  CANCEL - No language change. Computer OS language will be the
default.
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Maintaining Your Calculator

Updating the Calculator Operating System

TI Connect™ CE software lets you download operating systems for graphing
calculators.

Before you begin
+  Backup your calculator files (RAM, Archive, and Apps).

*  Make sure your calculator is turned on and securely connected to the
computer.

+ Ifyou have multiple calculators connected with USB computer cables,
disconnect all of them except the one you intend to update.

Warning: Do not disconnect the cable during a transfer.

To update graphing calculator operating systems
1. Click Actions > Send OS.

2. Navigate to the correct OS file for your model of calculator stored on your
computer.

3. Click Open.

Getting Calculator Information

TI Connect™ CE software allows you to getinformation about your calculator's
type, product ID, OS Version, RAM, Archive, Language, ROM Version, and
Hardware Version.

To view calculator information
» Click View > Calculator Information.
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Calculator: TI-84 Plus CE

S Product ID: 1300001B5E
I 11— 0S Version: 5.0.0.89
RAM: 262 kB (150 kB available)

Archive: 4,194 kB (1,853 kB available)

L= Language: EMNGLIS

ROM Version: 5.0.0.29

Hardware Version: 2

CLOSE

Compatibility with Graphing Calculators

Please refer to the TI-84 Plus CE Getting Started Guide for compatibility with
graphing calculators. Also see the TI-83 Premium CE Getting Started Guide.

Note: In general, TI-84 Plus CE graphing calculator files are compatible with
other TI-84 Plus and TI-83 Plus models.

Apps, Operating Systems and some data files with unsupported numeric types
do not share between models.

TI-Basic programs may need to be modified to display correctly on the high
resolution colour screen models.
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General Information

Texas Instruments Support and Service

Home Page: education.ti.com

E-mail inquiries: ti-cares@ti.com
KnowledgeBase and e-mail education.ti.com/support
inquiries:

International information: education.ti.com/international

Service and Warranty Information

For information about the length and terms of the warranty or about product
service, refer to the warranty statement enclosed with this product or contact
your local Texas Instruments retailer/distributor.
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http://education.ti.com/
mailto:ti-cares@ti.com
http://education.ti.com/support
http://education.ti.com/international

Index

changing

selected devicetype .._._...._...

computers

movingfilesto ..

copying device files ..

devicefiles

moving - .......

device type, changing

editavarname ._...

images

dragging to computer applications

saving as files ..

sending to device

saving

images as files ..

selected device type, changing ......

sending

images to device

13,20

13
13

13
13,20

21

10

13

13,20

13

TI DataEditor window

parts of

T1 ScreenCapture window

example

Index 28



	Legal Information
	Introduction to the TI Connect™ CE Software
	Using the TI Connect™ CE Software Window
	Parts of the TI Connect™ CE Software Window

	Using the Screen Capture Workspace
	Parts of the Screen Capture Window
	Capturing and Using Screens
	Saving Calculator Screens as Files
	Dragging and Dropping Screen Captures to Computer Applications

	Using the Calculator Explorer Workspace
	Parts of the Calculator Explorer Main Window
	Selecting a Connected Calculator
	Copying Calculator Files to the Computer
	Sending Files to Connected Calculators
	Converting and Sending Background Images
	Sending a Background Image to a Connected Calculator
	Deleting Calculator Files

	Using the Program Editor Workspace
	Parts of the Program Editor Workspace
	Creating a New Program
	 Editing a Var Name
	Protecting Your Program
	Saving a Program to Your Computer
	Closing a Program
	Using the Catalogue Panel
	Using the Syntax Reference Panel
	Sending a Program to a Calculator

	Maintaining Your Calculator
	Updating the Calculator Operating System
	Getting Calculator Information
	Compatibility with Graphing Calculators

	General Information
	Texas Instruments Support and Service
	Service and Warranty Information

	Index

